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Welcome to QPict Media Organizer
 

QPict Media Organizer is a powerful and easy to use Multimedia browser/viewer
for Mac OS. With QPict you can easily view and organize all your Multimedia files
including all common images, movie clips, fonts, VR, 3D and many other media
types. With QPict you can create slideshow of your Multimedia files for
demonstration purposes. With QPict you can convert between all common image
formats. The Multimedia files can be located on your hard disk, CD-ROM's or any
other media or remote on the Internet/intranet. With its uncluttered interface QPict is
designed to meet the needs from any kind of user from home enthusiasts to
professionals. For latest info about QPict please visit QPict web site:

http://www.glunet.se/qpict

Design Philosophy
The design philosophy behind QPict is quite simple. The application is designed to be
simple and easy to use but also versatile enough to fit all kind of users. This is
accomplished by using a user configurable interface where the user can add and
remove the functions as needed. It is also designed to be as fast as possible. To
accomplice this QPict is "lazy" meaning that time consuming work is only done when
actually needed and already executed work is cached so the same operation does not
need to be done twice. For example running a search through an index takes
sometimes a long time the first time it is run but the second time a search is run it uses
already collected data which speeds things up considerably.

Installation
To install QPict simply decompress the package (if you received it compressed) using
Stuffit Expander version 5 or later. The QPict folder can then be located anywhere on
your hard disk. If QuickTime is not installed install it from your Mac OS CD-ROM or
download it. You find links to QuickTime and Stuffit Expander on this web page:

http://www.glunet.se/qpict/additional-software.html

Requirements
QPict is designed to work many different configurations from older 68K computers to
the new G4 series. QPict has an advanced memory manager that makes it possible to
work with large index files in very low memory conditions although increasing
memory size will dramatically improve the speed of some operations.

Minimum Required Software

• Mac OS 7.5.3

• QuickTime 2.5

http://www.glunet.se/qpict
http://www.glunet.se/qpict/additional-software.html


Recommended Software

• Mac OS 8.1 or later (7.5.3 for 68K Macintosh)

• QuickTime 4.0 or later

Downloadable software

Required system software, updates and QuickTime are available from this web
page:

http://www.glunet.se/qpict/additional-software.html

Hardware Requirements

Any color capable 68K or Power PC Macintosh with minimum 4MB
memory free. Actual memory requirement depends on the size of index
files and the size of the media files being displayed. The requirements
also differ between creating/editing index and viewing index. Here is
small table to guide you:

Memory View Index Edit Index

4 MB 2000 files 1000 files

8 MB 8000 files 4000 files

12 MB 16000 files 8000 files

16 MB > 16000 files 16000 files

Note: Memory in the above table is actually free memory not total
memory available.

Note: The actual memory needed can differ from the table above
depending on kind of media files being used and what kind of
operations being processed.

Tip: If memory is running low saving the index will free up used
memory.

Working with smaller index and media files the recommended setting
is 8-12 MB. For larger index and media files allocate 12-20 MB for
QPict.

Quick Start
To get a start with QPict just drag and drop a folder/hard disk or CD-ROM
with images onto QPict icon in the Finder. Scanning the disk/folder can take
awhile. When the index is done you can save it on your hard disk for faster
access. To view images in the index just double-click them. While the image
is show you can use the left and right arrow key to go backward and forward
in the index. To remove an image, press backspace.

1. Launch QPict

http://www.glunet.se/qpict/additional-software.html


2. Drop a folder with media files onto the index window

3. Double click an item in the index window to view the media in a
window

4. Single click an item and press enter to view the image in full screen

Tip: Most controls and menu items have balloon help attached to it. Choose "Show
Balloons" from the "Help" menu to activate.

Overview
Index Window

The index window is analog to putting photo slides on a light table. It's from
here you can get an overview of you media files and organize and display
them. It mimics the behavior of the Finder as much as possible. When QPict is
first stared this is the window you'll see.

Index buttons

On the top right in the index window there are three buttons. These
buttons have corresponding menu items.

Show / Hide window toolbar

Sort order (A-Z or Z-A)

Show extended item information

Window title bar

The title bar in QPict index windows has two different states. This
applies to Mac OS 8.5 or later. If you open a folder as an index the title
bar will look like this:

This means that the index corresponds to a folder content. If the index
is modified the title bar will change to:



The dim state of the icon reveals that the index has been modified and
changes are not saved.

Toolbar

All items in the toolbar have ToolTip help. Position the mouse pointer on one
of the icons and wait until the ToolTip help is shown.

Menus

Use balloon help for information on the separate menu items.

Balloon Help

All menu items in QPict have Balloon help. Select "Show Balloons" from the
"Help" menu and direct the mouse pointer to the menu item(s) you want to
know more about. Most items in the Preferences window and other dialogs
also have Balloon help.



Working with Index
An index file in QPict is a file that contains small representations called thumbnails of
the actual media files. These thumbnails are either extracted from the actual image
file or QPict can create it from the image data by selecting "Create Thumbnails" from
the "Edit" menu. By saving the small thumbnails in the index file you can at a later
moment view the contents of an index without having to have access to the original
files which can be located on a CD-ROM, removable disc, network or anywhere on
the Internet.

Open
Choose open from the File menu. If navigation services are installed (standard in Mac
OS 8.5 and later) QPict will make use of these enhanced features. If navigation
services are not available you will get a plain old open dialog where you can open
index files only. The following describes the extra features you get with navigation
services installed.

Open Index file

Navigate to find the index file to open, select from the "recents" menu or from
the "favorites" menu. The icon of an index file looks like this:

Index file

If the index file was created by QPict 4.5 or later it will open instantly
otherwise the task window will display the open progress.

Open Folder contents

With navigation services you can also open entire folders or volumes with
media files. This is the preferred way to open media files when navigation
services are available. Navigate using Open until the wanted folder is found
and select it and press Choose. A new index will be created with the name of
the selected folder and all contents of the folder (including sub folders) are
imported to the index.

Tip: Press Option key when and after clicking "Choose" to import only the
top-level contents in the folder (skipping sub folders).

Favorites button

With navigation services you have access to a very useful feature called
favorites. With favorites you can create a list of often-used items (index files
or folders) that is easily accessed through a popup menu button in the open
dialog.



Favorites button

Tip: When choosing and index or folder from the "favorites" menu it is not
actually opened but it is selected. To open it immediately press option key
while making the selection from the favorites menu. Remember to depress the
option key immediately after clicking the "Choose" button. Otherwise only the
top level in the folder is being imported.

Recents button

On the right of the favorites button is the recent use button. Here you can find
a list of recently opened items. Otherwise the functionality identical to the
favorites button.

Recents button

Save
Saving an index is often a lengthy operation. This is because QPict looks into every
media file in the index and extracts media data and other information. This only
applies when saving a new index. Saving changes to an old index is much faster. In
return opening the index at a later stage is very fast. Opening an index with 15.000
items normally take less than a second. When the index is saved QPict is totally
independent of the actual media files (unless you want to view them). This makes it
possible to add such things as keywords and many other things to the index even
when the media files are not available.

Revert
With the "revert" command it is possible to undo all changes made to the index since
the last time it was saved. The "revert" command is only available if the index is
already saved.



Warning: Selecting "Revert" will cause all changes made to the index to be
lost.

Print Index
The index can be printed either with all items or the selected items only. Before
printing a new index select "Page Setup..." from the "File" menu to make sure paper
size and other options are correct. The settings made in the print dialog are saved in
each index file.

Print Options

Options for printing is located under the tab "Misc" in the preferences
window. These print options are global and are not saved in the index file.

Print frames

This checkbox determines whether to draw frames around the
thumbnails while printing.

Print header

With this checkbox on a header with index name and other info is
printed in the top of each page.

Print footer

With this checkbox on a header with index date and page number is
printed in the bottom of each page.

Print using media file

This option determines whether QPict uses the thumbnail images or
the actual media files when printing. To get high resolution, high
quality printout, turn this option on, to get faster printing turn this off.
If the media files are not available at print time the thumbnails will be
used regardless of this setting.

Print Selection

Make a selection of the items to be printed and select "Print Selection" from
the "File" menu press control while clicking in the index.



Print One

This is a shortcut to print without using any print dialogs. The default print
settings will be used.

Print from Finder

It is possible to print an index directly from the Finder. Select the index file
and select "Print" from the "File" menu in the Finder. If QPict is not already
running the application is launched and the index is printed without opening it
and QPict is quit when printing is finished. If is already running the index is
printed. QPict uses the print settings saved into the index file.

Adding media files
There are several ways to add media files to an index. Which way to use depends on
how you work with QPict and it's normal to use several different ways depending on
the circumstances.

Open folder

If you want to open a whole folder or volume of media files this is the best
option. Just select "Open" from the "File" menu and navigate until the wanted
folder is selected and then press "Choose" to open it. A new index is created
with the same name as the folder/volume that was chosen.

Note: This only works if Navigation services are installed. This is standard
with Mac OS 8.5 and later.

Tip: Press option-key when clicking "Choose" only adds the media files at the
top level from the folder/volume (excluding sub folders and theirs content).

Drag & Drop

If you want to add specific files to the index the easiest way is to use drag &
drop. Create a new index and drag the files and folders from the Finder onto
the index window. It is also possible to drag items from other index windows
and even from many other applications.

Import Files

To add a selection to an index without using drag & drop select "Import" from
the "File" menu. From this dialog it is possible to build a list of files and
folders to import.



Note: The preferred way to add items is to use the "Open" option or drag &
drop if you're using Mac OS 8.5 or later.

Removing Items
When talking about removing in QPict it is important to know the difference in
removing an item from the index and removing a media file. Removing an item from
the index leaves the actual media file untouched but removing from index and remove
media file moves the actual media file to the trash.

Remove from index only

To remove an item from the index but leaving the media file untouched do:

• Select the item(s) and select "Clear" from the "Edit" menu

• Select the item(s) and press backspace

• Select item(s) and press the delete button in the window toolbar

• Press Control-Option-Command keys and click on the item

Remove from index and delete media file

• Select the item(s) and drag them to the trash icon in the Finder

• Select the item(s) and press Command-backspace

• While viewing media in full screen press backspace



Tip: Pressing backspace to removes items causes an alert to be shown. This
alert can be turned of in the preferences under tab "Index".

Tip: The media files are not actually deleted, they are simply moved to the
trash so it's possible (unless the trash is emptied) to restore the media files
from there.

If the media file is located on a locked volume or the disk that contains the
media file is not mounted only the item is removed from the index.

Tip: To actually delete the media files you can select "Empty Trash" from the
"Script" menu.

Organizing
With QPict you have many different and convenient ways to organize you media
files. It is important to remember the difference between organizing items in an index
and organizing media files on your hard disk. When organizing items in an index or
between two index windows the actual location of the media file is not changed. This
way you can have index items whose media files are located in different folders on
the hard disk, on different CD-ROMs or on different Internet locations within one
single index.

Selecting items

Selecting items in QPict works like selecting files in the Finder. You can then
apply different operations on the selection.

Selecting single items

To select single items in the index simply click on them as you select
items in the Finder. Press and hold down the shift key to select several
items.

Selecting range of items

To select an area of items use the marquee tool. The marquee tool is
brought up by either positioning the mouse pointer between two items
or by pressing Command-Option. The cursor will then change to a
marquee pointer. Then drag the mouse over the items you want to
select. Press and hold the shift key down to extend an existing
selection.

Marquee selection cursor

Positioning the pointer between two items

To select a sequence of items click and select the first item in the



sequence and then use the left and right arrow keys while the shift key
is down to extend the selection.

Tip: To make a special selection of items that matches some special
characteristics use the built in search capability and use "Select item"
as a result action. See the section "Search" for more information.

Drag & Drop

Drag & drop is the most natural way to work with items. You work the same
way as you work in the Finder by dragging items to the desired location. There
are several useful shortcuts that simplify a lot when you want to organize
media file into different folders or index.

General

In general QPict behaves like the Finder but there are some cases when
the behavior is different. Generally if you work within an index
window or between index windows it behaves exactly as the Finder but
when you work between index window and the Finder QPict behaves a
little different.

Within index

Dragging and dropping within an index is a rearrange operation. This
is the same behavior you see if you move around items in the Finder
(using the icon view).

Tip: To make a duplicate of an item in the index press and hold the
option key when releasing the mouse button.

Between index

Dragging an item from one index window to another is a move
operation. That means that the item is removed from the source index
and then added to the destination index. This is the same behavior as
moving items from one folder to another (if the different folders are
located on the same volume).

Tip: To copy an item from one index to another press and hold the
option key when dropping the item in the destination index.

Between index and Finder

Dragging an item from the index into an folder in the Finder moves or
copies the media file to the destination folder. If the destination folder
is on the same volume as the media file the file is moved instead of
copied.

Tip: To always copy the media file to the destination folder press and
hold the option key when dropping the item(s) to the destination folder.

Tip: To remove the items from the index when they are dropped in a
folder in the Finder press and hold the command key when dropping



the items. This is great when you sort media files into different folders
and want to know which ones are not yet sorted.

Dragging items from the index to the trash removes the items from the
index and moves the media files to the trash.

Dragging item(s) onto an application icon (or alias) launches the
application and opens the media files in that application. This only
works if the application supports the media formats. This is great when
you want to open an item in another application.

Between index and other applications

Applications that accept files that are dragged from the Finder into the
application normally supports items dragged from an index window.
You can for example drag an image from QPict into a web page in
your favorite web editor.

View Options

There are four thumbnail sizes to choose from. A larger size takes more
memory but looks better. A smaller size makes it possible to view a larger
number of items on the screen.

Normal View

This is the default view setting. This gives an overview of the media files but
doesn't show any other info but the names of the items.

Show info View

By selecting "Show Info" from the view menu or clicking additional
information about each item are show. Selecting "Show Info" again hides the
additional information.



Note: When creating thumbnails it's possible to select which size the
thumbnail should have. Selecting a small size creates a smaller index file on
disk but the thumbnails will still be small even when selecting "Double View"
size.

Sorting

The order of the thumbnails in an index can either be unsorted, sorted by
name, size, kind or date etc. The sorting order can be reversed by selecting
"Reverse sort" meaning instead of sorting A-Z the index is sorted Z-A.

Note: Changing sort order can take a long time for larger index files.

Revealing files location

When working with index it can sometimes be handy to be able to quickly
locate where the original files is on the disk or CD-ROM. This is done either
by selecting the item in the index and select "Show Original" from the "File"
menu or by pressing the command key while clicking on the item in the index.

Reveal file location cursor



Open files in another application

When you have located the file you need in the index you either just want to
view it but often you want to use it in another application like editing it in
Adobe PhotoShop or inserting it into a web page in Claris HomePage. If you
simply want to open the file in another application you just Drag it from the
index onto the application icon in the Finder.

Note: If you often open the image in the same application you can configure
this in Preferences under the tab "Files". Select the helper application you
want. When that is done all you have to do is to press the alt-key while double-
clicking the item. The default helper application is Adobe PhotoShop.

Tip: If you want to insert an image into an existing document like page in an
layout application you can often just drag it from the index into the page
layout document.

 

Edit Items
When making changes to an item in QPict there is an option to apply the changes to
the index only (and leave the media files untouched) or to apply the changes to both
the index and media files. This option, "Apply changes to media file" is located in
preferences under the tab "Index". The option "Confirm changes to media file"
applies only when using the batch processor.

Creating thumbnails

A thumbnail is a miniature (scaled down) image of the actual media file.
Normal size is from 80x80 pixels up to 120x120 pixels. In order for QPict to
be able to display the items in the index thumbnails has to be created. Often
files created with a paint application have a thumbnail already but there are
reasons for recreating them.

Create from media file

This is the normal way to create thumbnails. The media file is read and
scaled down to the selected thumbnail size. Beware that this operation
is time consuming especially for large media files but it has only to be
made once for each media file.



Create from clipboard

In some cases it is desired to be able to create a thumbnail from
another image than the actual media file being processed. This could
be for media files not currently supported by QPict or for files that
doesn't actually contain any graphical media such as MP3 files. To add
a thumbnail copy an image or part of an image to the clipboard and
select the item(s) in the index on which you want to add the thumbnail.
Use the built in batch processor and do the following command:

Process items in selection with action thumbnail add from scrap and
apply changes to index and media file

Options

Apply to media file

If this option is on the thumbnail image is saved as a resource in the
media file otherwise the thumbnail is saved in the index only.

Size

The size in which the thumbnail is created can be changed. Larger size
causes larger file size and requires more memory to display but
generates a better looking image. Also note that when selecting view
size for the index the thumbnail must be at least the size of the current
view to fill the index item frame.

Compression

It is possible to change the compression ratio of the resulting
thumbnail images. A normal large size thumbnail is 3-8 K in size
depending on the compression settings. The higher quality selected
creates larger thumbnails but better image quality. Recommended
setting is "High quality" where normally no visible compression
defects is shown.

Sharpen

When a thumbnail is created the original image is scaled down to the
thumbnail size. This often causes the resulting image to be fuzzy. To
improve this QPict sharpens the resulting image. For some line art
images it is preferred to turn this option off.

Automatic creation

With this option turned on QPict checks all media files added to the
index and creates thumbnails for items that has none.

Recreate if smaller

With this option turned on QPict checks the size of the thumbnails and
recreates them if they are smaller than the size setting in the
preferences.



Remove thumbnails

There is sometimes need for removing thumbnails from index and/or media
file. One reason could be that you want to distribute an Internet based index
(see the section "Internet Access" for more information) and want it to be as
compact as possible. Or you want to save disk space by removing the
thumbnails from the media files and only save them in the index files. To
remove thumbnails use the built in batch processor:

Process items in selection with action thumbnail remove and apply changes to
index and media file

See the chapter "Batching" for more information.

Change item name

The name of an item can be changed directly in the index by clicking on its
name (this is the same behavior as in the Finder).

Clicking in the items name

Annotation

ANPA annotation is a standard of describing different media. You can assign
keywords, categories, caption and credits to each media file in the index. This
annotation is compatible with many major graphic applications such as Adobe
PhotoShop. Using annotations is a great way to organize your media files. By
applying annotation to each media file you can later very easy find a specific
sub-selection of media files from for example a large index of 15000 media
files. You can quickly find the 10 you were looking for by using keyword and
category search.

Change annotation

To change/add annotation for a single item in the index select the item
and choose "Edit Item Info" from the "Edit" menu. The resulting
window contains 5 different tabs.

Information

General media information such as file format, size etc. From
here you can edit the name and URL for the item.

Caption

Text field that can contain a longer description of the media
file.

Credit

Different text field that contains writer, copyright, location etc.

Keywords



A variable list of keywords describing this item.

Categories

A variable list of categories for this item.

Tip: To apply annotations to more than one item use the powerful
batch processor. Se "Batch Processing" for more information.

Shortcut: Press option key and click on the item name in the index to
bring open the info window for the item.

Remove annotation

To remove a single annotation field just remove the text. To remove all
annotations for one or more items use the built in batch processor:

Process items in selection with action annotation remove and apply
changes to index and media file

Apply change to many items

To apply the same change to more than one item use the powerful built in
batch processor. With this it's possible to change name, annotation and many
other things to thousands of items in one simple operation. Se the section
"Batch Processing" for more information.

 

Error Reporting
Due to the way QPict works with operating on many files/items in one single
operation it would be very impractical to display an error dialog every time QPict
encounters an error during an operation. Instead each item that generates an error is
marked with a small alert icon and when the operation is finished QPict simply
reports that there were errors during the operation.

Find items with error

There are two ways to find items that caused errors. First it's by visually look
through the index and spot the items with the alert icon. This works fine for
index with fewer items.

A more efficient way is to use the built in search engine to search for items



with errors. Simply do a search in the whole index:

Find items in current index whose error exist and move to result index for
every match

See the chapter "Searching" for more information.

Display error message

To display the error message click on the alert icon. Along with the error
message the operation which caused the error is displayed and the date and
time when it was and the error code that was the result of the error.

Clear error

To clear a single error press option key while clicking on the alert icon. To
clear error for all items in the index use the built in batch processor:

Process items in current index with action error remove and apply changes to
index only

See the chapter "Batching" for more information.

 

Changing Appearance
With QPict you can adjust the appearance of QPict to suit you personal taste and
needs. In addition to being able to change the appearance within the application QPict
is also fully appearance manager savvy meaning that if you install third party theme
files or install the Kaleidoscope utility QPict will automatically make use of the new
appearance.



Changing Index background

It is possible to choose between many different patterns to use as background
in the index window. Note that if you use another theme than Apple Platinum
or if you use Kaleidoscope and want QPict to reflect the background use the
"Default" setting. In the default setting the background from the current theme
(or Kaleidoscope setting) is used.

Note: Scrolling in the index is faster when the "Default" background pattern is
used.

Changing Index Font

The font being used in the index can be changed. Make sure not to use too
large fonts, otherwise the text will be cut of.

Selection appearance

The appearance of the selection can be changed. The default is to draw a
frame around each selected item. If the checkbox "Dim selection" is on no
frame is drawn. Instead the selected items are "sunk in" and the thumbnail
image is dimmed.



Normal selection Dim selection  

File name settings

The option "Hide file extensions" hides the extension for the file in the index.
For example the file "image.jpg" will be shown as "image" if this option is on.

 

Changing Defaults
To adjust the basic settings to fit your needs it is possible to set some default values
used when a new index is created. These settings are saved within the index so when
the index is reopened the settings will be restored regardless of current default
settings.

Show media info

If this option is on the extra info for each item will be shown in new index
windows.

Show window toolbar

If this option is on the window toolbar will be shown for new index windows.

View size

Set the default view size for new index windows. Choose between half size,
normal size, large size and huge size.

Window width

Default width for new index windows in items. Note that the actual size of the
window depends also on the selected view size.

Window height

Default height for new index windows in items. Note that the actual size of the
window depends also on the selected view size.



 

Index Settings
 Selecting "Index Settings" from the "File" menu opens this dialog:

Settings made in this dialog is saved in the index. This lets you add comments and
URL for an index that you want to distribute or archive.

Information

Index Comments

Text field for free usage up to 255 characters long.

Index URL

URL field for free usage. This URL will be displayed if the "Show index
comment" is checked as a clickable link. The link will open in the default web
browser.

Actions

Start slideshow

By selecting this checkbox a slideshow will start when the index is opened.



Show index comment

By selecting this checkbox the index comments dialog will be shown every
time the index is opened:

Clicking on the icon opens the Index Options window.

Security

An password can be assigned to a index. The next time the index is opened
this password will be required in order to view the content of the index. This
way you can upload the index on the Internet and have control of who can
view it.

Locking index

To assign a password click the "Set Password…" button and enter a password.
If the index was already password protected the current password is requested
in order to assign a new one or remove password protection.

Using Keychain

If the computer is running Mac OS 9 or later a feature called KeyChain is
available. This feature makes it possible to save all kind of different passwords
in a global encrypted database. Applications that are KeyChain capable can
then acquire the password from that database. This way you can after the
KeyChain is opened access all password protected index files without having
to enter password.



Working with Media
In addition to being a great organizer for your media files QPict is also an excellent
viewer. QPict supports viewing of most common media file formats such as images,
movie clips, 3D models, MP3 songs and fonts.

View media files
Images

QPict can display all of the most common still image formats available. The
images can be either show in 100% scaling or scaled to fit the window/screen.
If the image is larger then the screen scrollbars will enable viewing of the
parts that doesn't fit on screen.

Movies & Animations

QPict can display all of the most common movie and animation file formats.
The are displayed in a standard QuickTime movie window with all the
controls available to stop, play change volume etc.

Fonts

QPict can display bitmap fonts, TrueType fonts and suitcases. There is a
simple AppleScript available in the Script menu to open the fonts currently
installed in the system.

QuickDraw 3D files

QPict can display and interact with QuickDraw 3D models. When the model is
viewed all the controls to rotate and zoom etc. are available.

View in window

View in window means that the media file is shown in a resizable window.
This makes it possible to have any number of media files shown at the same
time. The default behavior when double clicking an item in an index is to view
the media in a window.

Navigation

When a media file is shown in a window it is possible to step to the
next item in the index and view that in the current window. To do this
press space or tab. To display the previous item in the index press and
hold shift while pressing space or tab.

Shortcut: Press enter in view in window mode to go to full screen view.

Full screen view

In full screen mode the media file takes over the whole screen and hides the
menu bar and any other visible windows. This is the default behavior when
pressing one of the action keys (enter or space) in the index.



Navigation

When a media file is shown in full screen it is possible to step to the
next and previous item in the index. To do this press left or right arrow
key. Press up arrow key to jump to the first item in the index and down
arrow to jump to the last. To delete the currently shown media file
press backspace. Press escape or enter to exit full screen mode.

Shortcut: Press "S" to change between scale to fit and 100% view.

Shortcut: Press "N" to show or hide name.

Quick View from Finder

To quickly view an image from the Finder drop the media file onto the QPict
icon in the Finder. The media file will be shown in a window and it will be
added to the index behind it.

Options

Several defaults can be changed in preferences under the tab "Display".

Slideshow
Using the slideshow is a perfect way to run auto demonstrations. Using the "Start
slideshow" option in the "Index Settings" is a great way to distribute your index to
clients for auto viewing.

Begin Slideshow

The slideshow is started by selecting "Slide Show" from the "Script" menu or
by pressing command-H. If an item is selected in the index the slide show
starts from that, otherwise the slide show is started from the first item in the
index.

End Slideshow

The slideshow is stopped by pressing the escape key. When the slide show is
stopped the last image that was shown is still visible. To return to the
slideshow click the "< >" button in the navigator window:

Options

 In the preferences window under the tab "Slideshow" several different options
can be set.

Delay

The delay in between images can be set from 1 second up to 10 minutes.

Sequence



The sequence setting determines in which order the media files will be shown.
Possible selections are forward, reverse or random order.

Windows

Here you can choose to hide the info window and/or the navigation window
while the slideshow is running.

Changing Appearance
With QPict you can adjust the appearance of QPict to suit your personal taste and
needs. In addition to being able to change the appearance within the application QPict
is also fully appearance manager savvy meaning that if you install third party theme
files or install the Kaleidoscope utility QPict will automatically make use of the new
appearance.



Searching
QPict has a very powerful search engine where you can search for different file and
media characteristics, keywords, categories and many other user changeable text
fields. The search engine is fully multithreaded meaning that you can run several
different search tasks in parallel. Complex search settings can be saved and added to
the "Script" menu as easy to use commands.

Search for Items
Items search searches through the index or current selection for items that matches
selected search criteria.

Selecting Source

The selection of items can be either all items in the index or the selected items
in the index. After the search task is started the selection is not changed by
adding files to the index or changing the current selection.

Tip: If you want to batch process a special sub selection in the index you can
first run a search task and let QPict select the matching items and then switch
to batch process and process the selection.

Selecting Search Criteria

Search criteria is the actual criteria to test to each item in the source. It can be
any of 45 different criteria and by clicking "More Choices" it is possible to
test any number of different search criteria on every item in the source.

Tip: One action can be used more than one time. For example if you want to
find all items with keyword "Nature" and keyword "Tree" use the "keyword



contains" action twice.

Selecting Result Options

You can choose if you want the batch operation to apply to the index only or
to both the index and the media file. If the media file is not available the
process will apply to the index only.

Move to result index removes the item from the source index and inserts it to
the result index. Copy to result index inserts the items into the result index but
leaves the source index unmodified. Remove from index simply removes the
matching items from the source index while select item simply selects all
matching items.

Tip: By choosing "select item" as result option it's when the search is finished
possible to switch to the batch tab to apply an batch operation on the items
that matched the search criteria.

Saving and recalling settings

Any search settings from a simple one to a very complex one can be saved for
later use. This is done by selecting "Add To Script Menu" from the favorites
popup:



Append the name with "/" and a letter to add a shortcut key combination for
the Script menu.



Search for Duplicates
This option searches the entire index or a sub selection of it for possible duplicates.
Media characteristics such as media data size and dimensions are compared. It is
possible so search for duplicates in very large index files with low memory
requirements but the search process might take a long time. The result is presented in
a result window where all duplicates are marked selected while the "originals" are not.
This makes it possible (after inspection of the search result) to press Command-
Backspace to move all duplicate files to the Trash.

Selecting Source

The selection of items can be either all items in the index or the selected items
in the index. After the search task is started the selection is not changed by
adding files to the index or changing the current selection.

Selecting Result Options

You can choose if you want the batch operation to apply to the index only or
to both the index and the media file. If the media file is not available the
process will apply to the index only.

Warning: Make sure to look through the search result before deleting any
duplicates. It is possible for to different media files to have the same
characteristics and therefore match in the duplicate search.



Batching
Batch processing is when you are applying one or more operations on many items in
the index. The batch processing in QPict is very powerful and yet easy to use. With
batch processing you can apply keywords, categories and many other things to
thousands of media files in one single operation. The batch engine is fully
multithreaded meaning that you can run several different batch tasks in parallel.

Warning: Batch processing is not undoable meaning that with the wrong
batch criteria's you can destroy your media files!

Note: Batch processing might use a lot of memory when processing a large
index.

Selecting Source

The selection of items can be either all items in the index or the selected items
in the index.

Tip: If you want to batch process a special sub selection in the index you can
first run a search task and let QPict select the matching items and then switch
to batch process and process the selection.

Selecting Batch Options

Batch options is the actual operation to apply to each item in the source. It can
be any of 31 different options and by clicking "More Actions" it is possible to
apply any number of different operations on every item in the source.

Tip: One action can be used more than one time. For example if you want to



add keyword "Nature" and keyword "Tree" to the items use the "keyword add"
action twice instead of running the batch task twice.

Selecting Result Options

You can choose if you want the batch operation to apply to the index only or
to both the index and the media file. If the media file is not available the
process will apply to the index only.

Warning: Applying batch process to media file is not undoable so use this
option with caution.

Tip: Selecting "index and media file" as result option lower memory
requirement in many batch operations.

Saving and recalling settings

Any batch settings from a simple one to a very complex one can be saved for
later use. This is done by selecting "Add To Script Menu" from the favorites
popup:

Append the name with "/" and a letter to add a shortcut key combination for
the Script menu.



Image Conversion
With QPict you can convert from all supported media files into many common image
file formats such as TIFF, JPEG, PhotoShop and many others. This is very hand if
you for example want to convert a TIFF image into a JPEG image to use in a web
page or if you simply want to compress an existing JPEG image into a smaller one.
Image conversion works as all other functions in QPict in multitasking. That means
that you can convert thousands of images into several different file formats in parallel.

Note: The original media files are not altered. New media files for destination is
created.

Prepare to export items

Select the items in the index that you want to convert and:

• Choose "Export" from the "File" menu or

• Press command-E or

• Press X in the window toolbar or

• Control click on one of the items to bring up contextual menu

Next you will be presented with the following dialog.

Apart from selecting file format and destination you have the option to have
QPict automatically change the file extension of the destination file. If you for
example convert the file image.gif into JPEG QPict will rename it to
image.jpg.



Selecting destination

If you click "Change" in the "Destination path" or the checkbox "Ask for
destination" is checked the following dialog is shown:

Here you select the destination where the converted files will be saved.

Selecting output format

QPict is currently able to convert all supported media formats into the
following list of destination image files:

Compression settings

For some image file formats it's possible to change the compression settings or
color mode for the destination image.



Selecting lower quality creates smaller destination file but decreases image
fidelity.



Internet Access
With the explosion of Internet use it is often desired to share media files with other
users on the net. QPict is designed to do this easily. Example of usage is to distribute
a index without the actual media files (which can take up several hundreds of
megabytes). Downloading the index will be done quickly since it is often very small
(from a few KB to a few MB depending on contents), When the index is downloaded
the user can view the index by thumbnails and even search for keywords and many
other criteria. When the user found a file he/she wants it is just to double click the
item to download the actual media file.

Add Internet location

Downloading files

If an item in the index contains an URL the actual file can be downloaded
either by double clicking it or by selecting "Download Media" from the
"Script" menu.

Uploading files

To upload a media file to a remote location select the item(s) in the index and
select "Upload Media Files…" from the "Script" menu. QPict will prompt for
the address (se the dialog above).

Creating an Internet only index

1. Create the index and add media files

2. Uploading the files

3. Removing local links



4. Making it compact



Task Management
Every operation in QPict is called a task. Any number of tasks can be run in parallel
but the more tasks that are run in the same time the slower the computer will be. Most
tasks in QPict is displayed in the task manager window. Some tasks such as
background creation of thumbnails and caching is invisible and will not show up in
the task manager window.

The Task Window

The task manager window is shown automatically when a task is started. If the
window is behind another window it can be brought to front by selecting
"Task Manager" from the "Window" menu.

Pausing task

To temporary pause a task press the pause button "||". To continue a paused
task press the continue button ">". Some tasks like ftp tasks cannot be paused.

Terminating task

To terminate the execution of a task press the stop button. Some tasks like
save task cannot be terminated.

Task Settings

Each task running in parallel is dedicated time to execute based on their
priority. The overall priority to all tasks can be fine tuned in the preferences
dialog. If the computer is very slow while executing tasks select a higher
value. To make tasks run faster select a lower value.

Completion sound

When a task that has executed more than 10 seconds completes a completion
sound is played. This can be turned of in preferences.



Frequently Asked Questions - FAQ
This is a collection of often asked questions.

Question

Why does the task manager display 0 of 100% for a long time and then
quickly pass through 1-100 and finish when searching duplicates?

Answer

In some cases the data needed to run the search is already in memory while in
other cases the data has to be read from the media files which can be quite
slow.

Question

Sometimes a search takes a long time and other time in the same index it
finishes very quickly. Why the difference?

Answer

In some cases the data needed to run the search is already in memory while in
other cases the data has to be read from the media files which can be quite
slow.

Question

Saving an index file sometimes takes a long time, why is that?

Answer

During save QPict extracts media information such as media size, color depth
and many other data, Annotation info is also extracted if available. This
process takes some time but the benefit is that when the index is saved it is
100% independent of the original media file and the index is opened instantly.
The only time the original media files has to be available is if you want to
view them otherwise you can search and organize without them.
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